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Welcome from Meemaw!
Hello! Welcome to a special issue of The NEW
PCLinuxOS Magazine devoted to KDE4. We have
compiled all the KDE4 articles from past year into
this one special issue. Our cover was designed by
parnote, and takes us on a journey through the
many appearances of KDE over the years. Along
with that journey, I would like to highlight some of the
developmental milestones of KDE.
KDE was founded in 1996 by Matthias Ettrich, who
was a university student in Germany at the time. He
wanted to create a unified desktop environment and
set of applications that would make the Unix
operating system work more smoothly.
KDE1 was released in July of 1998. The release
statement said, “KDE seeks to fill the need for an
easy to use desktop for Unix workstations, similar to
the desktop environments found under the MacOS
or Window95/NT. “
KDE2 was released in October of 2000. Quoting the
release statement, "With the experience gained from
developing KDE 1, we almost completely re­
engineered KDE 2 to make it even more intuitive,
powerful and user friendly" and offered even more
applications to its package.
KDE3 was released in April of 2002, announcing
“The KDE Project today announced the immediate
availability of KDE 3.0, the third generation of KDE,
a free and powerful desktop for Linux and other
UNIXes.” This is the version with which many of us
started our Linux adventures. In fact, PCLinuxOS

stuck with KDE 3.x as the desktop environment for
its main version up through PCLinuxOS 2009.2.
KDE4 Software Compilation was released in January
of 2008. However, it was such a departure from
KDE3 that many users disliked it, complaining that it
was unstable. KDE 4 embraces, in part, the
Nepomuk project, which represents a new way of
thinking about the computer desktop and the
interrelationship of data across that desktop. Some
asked for KDE 3.5 to be forked and continued (via
the Trinity Desktop Environment project), and many
have stuck with KDE 3.x until very recently. The first
version of KDE4 that was a standard feature in a
PCLinuxOS Live CD was KDE4.4.2, which was
included in the new PCLinuxOS 2010 when it was

released in April of this year. The main departure is
the change from the structure of the environment
itself, from the former desktop, kicker and possibly
the use of superKaramba to the introduction of the
Plasma desktop, which was designed to merge the
previous components into a desktop that looks
sharper and works better. We have since been
upgraded to KDE4.5, and most everyone's systems
are working well, despite the rocky start of KDE 4.
However, holdouts remain, as many users have yet
to embrace KDE 4.
The magazine staff believes that the combination of
these articles into this special issue will give you a
handy, easy to access guide with everything right
where you need it. Enjoy!
Meemaw, Asst. Editor
PCLinuxOS Magazine

Welcome From The Assistant EditorWelcome From The Assistant Editor

http://nepomuk.semanticdesktop.org/xwiki/bin/view/Main1/
http://trinity.pearsoncomputing.net/
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by Andrew Huff (athaki)
Today I'm comparing the interfaces for Windows 7
and KDE 4.3, making note of how they compare,
differ and which one is best for 'Joe User'.

Windows 7
I'll start with Windows 7, which is one of the most
anticipated releases for the Microsoft camp ever
(especially due to the numerous bad reviews of
Vista). Windows 7 comes in six different versions,
three of which will be available to the consumer at

retail: Windows 7 Home Premium, Professional and
Ultimate. Windows 7 Starter is targeting installation
on netbooks, while Windows Home Basic is
intended for sale only in emerging markets. The
sixth version, Windows 7 Enterprise, falls right below

Windows Ultimate, and is
intended for volume
licensing.
Most users will go for the
Home Premium edition,
unless they are looking for
specific business­related
features of Windows 7
such as: connecting to a
domain, operating as a
Remote Desktop server,
file system encryption,
presentation mode and
Windows XP mode
(requires an additional 1
GB of memory, 15 GB hard
drive space, and a
processor capable of
hardware virtualization).
Windows 7 Ultimate will not
have any of the 'Ultimate
Extras' that Vista had.
In the end, if you're just

going to be doing basic word processing, listening to
music, watching DVD/Blue Ray/Video files and
surfing the internet, Windows 7 Home Premium will
be the one best suited.
Windows 7 does have a smaller initial memory
footprint, and programs feel a little snappier than on
Vista, but in my experience the differences were

negligible from when I used Vista. User Account
Control does seem less 'in your face' than in Vista.
However, I'm personally so used to it that it's difficult
for me to determine when it's not notifying me about
something. In the interface department, the taskbar
is larger (reminiscent of KDE) and when one right­
clicks, one gets this nice menu:

This is nice, but how many average people would
actually right click on a taskbar icon? The start
menu is not too different from Vista, but it does make
'shutdown' the default option.
The ribbon interface has also been incorporated into
Wordpad and Paint (screen shot on the following
page).
Windows 7 also includes something called
'Libraries', which combines folders of your choosing

KDE 4.3 and Windows 7 ComparisonKDE 4.3 and Windows 7 Comparison
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into one window. For
example, the documents
library includes the
folders 'My Documents'
and 'Public Documents.'
One can add folders to
the default libraries
(Documents, Pictures,
Videos and Music) or
create their own.

PCLinuxOS KDE 4.3
In the PCLinuxOS version of KDE 4.3,
the PC menu remains mostly similar to
the KDE 3.5.10 version. However, the
'factory shipped' version of KDE 4.3
comes with an empty desktop, which is
similar to the default desktop of Ubuntu.
KDE 4.3 has a dedicated taskbar button
for any media that could be inserted
into the computer. This ranges from
DVD and CDs to flash media and
camera cards. (below)

Another aspect is the folder
preview option when one
hovers over a folder on the
desktop: ­ ­ ­ >

Memory use on KDE 4.3 seems rather efficient. On
my 2GB RAM machine, KDE 4 is using 221MB with
Firefox open, which could mean that it could be
installed successfully on computers with 256MB of
RAM. Windows 7, on the other hand, has a minimum
memory requirement of 1 GB. The biggest
difference for users switching from KDE 3.5 to KDE
4.3 would be getting used to the new file manager,
Dolphin.

The interface is very intuitive
and straightforward. It
shouldn't be too big of a
problem for new users to
use.
So, which version should
'Joe User' install? As stated
above, if they're just doing
basic tasks, Windows 7
Home Premium would fit

KDE 4.3 and Windows 7 Comparison



6

their bill. However, as we all know, PCLinuxOS is
more than capable of doing those same tasks as
well. PCLinuxOS also has the good fortune of being
'gratis', whereas one would have to pay at least
$119.99 US to acquire an upgrade license for
Windows 7.
The full retail version of Windows 7 Home Premium
will set you back $199.99 US. Windows 7
Professional (equivalent to the Vista Business
Edition) will cost $199.99 US for the upgrade, and
$299.99 US for the full retail version. If you opt for
Windows 7 Ultimate, the upgrade version will cost
$219.99 US, and the full retail version will run you
$319.99 US. Microsoft has offered heavily
discounted "pre­orders" of Windows 7 Upgrade,
allowing Windows XP and Windows Vista users to
upgrade to Windows 7 Home Premium for $49.99
US, and to Windows 7 Professional for only $99.99
US.
It's also important to keep in mind that these prices
reflect only the price of the operating system. Under
a Windows operating system, you still have to pay
for the applications that make you productive.
Running PCLinuxOS on your computer gives you
not only the operating system free of charge, but
also free access to all of the more than 11,000
programs in the PCLinuxOS repository.
Aside from the cost, Windows 7 has much "loftier"
hardware requirements. The 32­bit version of
Windows 7 requires 1 GB of memory, a video card
with a minimum of 128 MB of memory, and 16 GB of
hard drive space. The 64­bit version of Windows 7
requires double the memory (2 GB) and 20 GB of
hard drive space. Contrast this to KDE 4.3, which
requires only 4 GB of hard drive space, and will run

on a computer with as little as 256 MB of memory,
although 512 MB of memory and 10 GB of hard
drive space are recommended.
So there you have it – a comparison of KDE 4.3 and
Windows 7. Where do you want to go today?

KDE 4.3 and Windows 7 Comparison

http://www.pclinuxos.com/wiki/index.php/Main_Page
http://pclinuxos.com/?page_id=188
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by The­One­Who­Uses­It

PCLinuxOS is one of the eaiest Linux distribution to
install. It is adapted for new users migrating from
Windows and allay them of their fears of Linux. It is
also used by both seasoned and veteran Linux
users. A platoon of community users have risen to
the ranks of packagers and developers, wireless and
networking gurus, the artists and desktop­
decorators, the testers and ISO remaster masters,
etc. PCLinuxOS is more than just a Linux
distribution. For many, it is a way of life.

As technology sets its pace towards development
and the operating system future, PCLinuxOS is right
on the heels of big names in Linux. Although
PCLinuxOS wasn't on the KDE 4 summit, when
Mandriva, Fedora, [add other Linux distros who
shipped KDE 4 early in its development] shipped
theirs, main developer, Texstar was the smarter for
his wait­and­see strategy. It paid off (at least in terms
of the stability of the version) and pleased a
multitude of PCLinuxOS users who had now
upgraded. Short stories and posts of which are
abundant in the forum.

KDE 4.3.1 on PCLinuxOS still has its kinks and
potholes but a wise PCLinuxOS user's words comes
into mind ­ "No operating system is perfect." The
PCLinuxOS repository still lacks several KDE 4
applications that were available on KDE 3.5.x but
lPCLinuxOS users are assured that these upgrades
will be packaged and distributed sooner rather than
later. The PCLinuxOS Support Forum has a thread
(and hopefully a separate section) for KDE 4.

This article is about my personal experiences using
KDE 4.3.x duing the last couple of months. And I
should add that it was rather radically simple and
satisfying. It was comparable to watching my best
friend's son learning to turn over and crawl, walk,
run, jump, swim, etc. Certainly, I ran into kernel
panics and hanged reboots, and had reinstalled
several times but those initial testings were done on
VirtualBox so nothing was really lost. Back then KDE
4, was still a hard conversion but leave it to the
PCLinuxOS developers and they've come up with
the ingenius task­kde4 that ensures an error­free
transition to the latest DE version.

For the benefit of this review, I recreated my current
installation using VirtualBox so I might be able to
include snapshots of the default
images for easy references.
Typically, any PCLinuxOS install
would do but I opted for the best
and sensible choice, Minime09.
This way, the recreation is minimal.

There are a few important things to
bear in mind. Backup your most
vital and important files. I am in the
habit of saving to a removable hard
disk and making remasters. Apart
from the visible folders, you might
want to take a look at the hidden
files which contain your Firefox
bookmarks and addons,
newsfeeds, received and sent
emails, 3D effects settings, etc.
The PCLinuxOS Support Forum
and #pclinuxos­support on

Freenode are at a click of an application to help any
users with issues and queries.

I had a clean install ... well not exactly. As root I
cleaned up all the /home partition of all hidden dot
files but left my humongous music, photos and
video collections intact. On installing Minime09, I
only reformatted the root partition. It took me a bit of
work to get some of my old configuration that I had
backed up back in place but they're back. I know this
may sound a bit foolish but I did get a fresh KDE
4.3.1 to look like my old KDE 3.5.10 setup leaving
the KDE 4 touch and feel to it. It seem to be faster,
responsive, stylish and more importantly, stable than
the previous. Why did I want to set it up to look like
KDE 3.5.10? Well, if you are curious, you'll just have

A User's KDE 4.3 Experience on PCLinuxOSA User's KDE 4.3 Experience on PCLinuxOS

A fresh install of PCLinuxOS Minime 09
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to post the question on Sandbox in the PCLinuxOS
Forum..

In addition, I have modified the GRUB background
and splash together with the KDM login manager
and KSplash to match the KDE 4's Air theme. The
components and configurations are available but
since I am not a packager, I have not made it
available to anyone who might like to use them.
However, if you are interested, you may make the
request on the PCLinuxOS Magazine forum.

A User's KDE 4.3 Experience on PCLinuxOS

MiniMe '09 Grub

Modified PCLinuxOS KDE 4 GRUB Menu

MiniMe09 Splash screen
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Like I mentioned, there are still a shortfall of task­
specific applications but overall KDE 4.3.1 is a
usuable DE. Obviously, we won't have the same
preferences so I will not mention my preferred
applications like Firefox, KMail, KVirc, GIMP,
Inkscape, Amarok, Kino, VLC, etc. but instead
comment on the essential system applications and
their interactions with KDE 4.3.1 in general.
There was a time long ago when I wondered which
was important of the GUIs ­ Synaptic or the
PCLinuxOS Control Center. Yeah, there'll be those
who'd say they're rip­offs but that point is moot. For
me, they're neither or both. Linux, at a time almost
forgotten was apt­get and drakconf. These days, the
icons that launches specific tasks are advances
towards the right direction. Most won't have to worry
about the CLI and focus on getting the job done
instead. Still, the
command line is the
vital nerve to the
kernel heart.
Synaptic on KDE 4.3.1
is pretty much the
same whether you run
it on KDE 3.5.10,
GNOME, XFCE, LXDE
or E17. It's selecting
the applications you'd
want to upgrade, install
or remove. The
PCLinuxOS Control
Center is the same as
well.

A User's KDE 4.3 Experience on PCLinuxOS

KDE Splash for MiniMe09
(below)

KDE 4.3.1 (right)
and a modification (below right)



10

A User's KDE 4.3 Experience on PCLinuxOS

Modeified Login Manager for KDE 4.3.1

KDE Splash for MiniMe09 Modified Splash for KDE 4.3.1

Splash for KDE 4.3.1
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One that was actually different is the KDE Control
Center. The tree layout is different and the sections
(though logical) needed getting familiar with. One
minor issue I have is with displaying Xinerama. For
whatever reason, I cannot seem to get a 2560x800
wallpaper across the two monitors. Eventually, I may
ask the more knowledgeable community members in
the support for for any input and solution. So for
now, I content myself with the single laptop display.
I use a combination of Plasmoids and
Superkarambas, which works out really well for me.
I am too selective for my own good. Apart from the
common layout of the taskbar, I have replaced a
couple of widgets (such as the Plasmoid Smooth­
Tasks) and am running a home­brewed system
monitor widget. I also use a combination of KDE

native 3D effects
and Compiz. I
must admit that
transparencies
are better on
KDE 4.3.1 than in
3.5.10. And to top
it all, I launch
applications via
Cairo­Dock using
the Neon theme
adding my own
personal touch
on the icons.

So those were
the few good
things (and bad).
On my wishlist
are a fix to the
Menu Editor that
can't seem to run
(D­bus related
issues, possibly)
and a few more
applications I've
been waiting to
get packaged

(like a KDE­native
dictionary
application,
although I'm sure I
still have to try out
KDing), and better
functionalities to
Plasma.
One thing I am sure
of though. I have
ventured to the path
of KDE 4.3.x and I
know I will continue
to use it. Will I still
use KDE 3.5.10? If I
have to, I won't
mind spinning with
an old friend.

A User's KDE 4.3 Experience on PCLinuxOS

Default Desktops for MiniMe09 (left)
and PCLinuxOS KDE 4.3.1 (top right)

My KDE 4.3.1 Desktop



12

by Patrick G Horneker
With Windows7 to be released on October 22nd, we
really need to push the idea that consumers should
choose PCLinuxOS over Windows7. Microsoft
started its television advertising campaign using, of
all things, a seven year old child as a spokesperson.
The selling point in the ad was "I am a PC", and the
words "more happy" were actually used in the
advertisement to promote Windows7, as well as
selected quotes supposedly from the major
computer media companies, especially when ZDNet,
not two weeks ago, said that the Linux desktop was
ready for the mass market.

The screenshots from Andrew's article comparing
Windows7 to KDE4 are solid evidence that much of
the KDE4 desktop has become part of the
Windows7 desktop.

With this in mind, I shall present the top seven
reasons why consumers should replace Windows
with PCLinuxOS, instead of upgrading to Windows7.

7. Windows7 requires 1GB of
RAM, with 2GB recommended for
performance. PCLinuxOS requires
128MB for the MiniMe, LXDE, and
some variants, while 256MB is the
requirement for the KDE3 and
GNOME variants of PCLinuxOS.
512MB is the minimum for the
KDE4 desktop.

6. PCLinuxOS is like Windows7 ­ until it comes to
viruses, trojan horses, spyware, malware, and other
malicious software: Never had it, never will.

5. PCLinuxOS is available as an installable LiveCD
that can also be booted from a USB flash drive, or a
memory card for that matter. There is no live version
(not even a demo) of Windows7 to try out.

4. PCLinuxOS is easy to install and administer. In
fact, it is so easy, even the seven year old child who
does the advertisements for Windows7 can
administer PCLinuxOS.

3. Hewlett­Packard All­in­one devices work out of
the box with PCLinuxOS. Even with Windows XP,
extra software is needed to get these printers
working.

2. Wireless networking is made easy with
PCLinuxOS, especially if you have an Atheros
chipset built into your laptop. Simply run drakroam
and you are set for secure wireless freedom.

...and the number one reason for
installing PCLinuxOS over
Windows7:

1. Consumers will get the best
desktop made by the best people on earth!

Top Seven Reasons to Choose PCLinuxOS over Windows7Top Seven Reasons to Choose PCLinuxOS over Windows7
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by Meemaw
With the change in KDE from version 3 to version 4,
we've seen many changes. Some of us are hesitant
to try the new KDE4, or have tried it and don't like it.
Others (like me) have jumped in and not looked
back. I was nervous about it, but as I find out where
more of my configuration aids went, I like it more and
more.
Obviously, changes have also been made in the
KDE Control Center (commonly seen in the menu as
“Configure Your Desktop”). Many of the items we are
accustomed to seeing are still there, only rearranged
a bit. I think that the old main menu with ten items
was condensed into six items by combining them
into some more meaningful section. Let's look:

Look & Feel
The first item in the list is 'Look & Feel' rather
than 'Appearance & Themes', which was in
KDE3. It actually is a combination of 'Appearance
& Themes' and 'Desktop', so almost everything is
in one spot. One exception is 'Themes' which is
now in 'Folder View Settings' or 'Desktop Settings'
(in the right­click menu on your desktop.) The
other exception is 'Panels,' which was in
'Desktop' in KDE3. The panels are configured in
KDE4 by right­clicking the panel and choosing
'Panel Settings.'
Under 'Look & Feel' are four sub­menus;
'Appearance', 'Desktop', 'Notifications' and
'Window Behavior'. Basically, anything you might

do to configure how your
computer screen looks or
even sounds like is in this
section. The Appearance
section lets you change
things like colors, fonts,
icon sets and types of
emoticons. In Desktop,
you can enable desktop
effects, configure multiple
desktops, designate
screen edge actions or
configure your screen
saver. Notifications lets
you assign sounds to
various events (like the
revelie sound that K3b makes
when the burn is finished
successfully.) Window
Behaviors can also be
configured.

Advanced User Settings
The next section is
'Advanced User Settings,'
where you can configure
things even more. The
subsections include
Akonadi, Audio CD's,
Autostart, Desktop
Search, Desktop Theme
Details, Device Actions,
File Associations,
Hardware, Session
Manager and KDE
Wallet.
Akonadi is a newer KDE4
feature that is supposed
to create a common link
across your applications
(like e­mail, calendar,
instant messenger, etc.)
which allows you to input
information only once and
it could be accessed in all
apps (instead of having to
put e­mail addresses into
Thunderbird and again in
Kontact.) It is not
included in the 2010 beta.
Desktop Search uses

Nepomuk which links data across apps so a search
will bring up all relevant files no matter which
program created them (and a tagged photo in one
app will also tag it in another.) The goal is to link
data across desktops so collaboration is possible.

KDE Control Center's New LookKDE Control Center's New Look
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Desktop Theme Details will allow you to configure
your desktop even more... the subsections allow you
to change individual aspects of your theme to suit
yourself.
Device Actions lets you configure what
you want to happen when you connect
a new device to your computer.
Hardware contains configuration
backends for HAL, Network Manager
or Bluetooth.
KDE Wallet can be configured here, if
you want to use it.
Session Manager lets you configure
how KDE starts. If you leave a
particular program running and the
next day start the previous session,
that program will be started as well.
Personal
The Personal section contains items
to configure your install specifically for
you.... user password and icon and
what default folders are used for
documents, pictures, etc.; accessibility
issues and default applications. Here
you also find Regional and Language,
which will allow you to change your
default language from English to your
native language (if it is one of the
many languages that PCLInuxOS is
capable of using.) You can also
configure how your system displays
date, time, money, and so on. If your

keyboard layout is different from my US keyboard,
you can change it here.
System

The next major section is System,
which can configure some of the
things that PCC does. You will be
asked for your root password here
as well. Login Manager lets you
configure what login screen you
see and which users are listed
(you can choose not to have root
listed if you wish.) Power
Management is in this section, as
is Samba configuration. Task
Scheduler lets you schedule any
task you want to be performed on
a regular basis.
Network & Connectivity
You can configure proxy, some
generic connection preferences
(like timeout values) and service
discovery here. Sharing with local
folders is also configured here.
Computer Administration
Computer Administration includes
configuring your date & time, your
display (resolution, power control
and designation of multiple
monitors. The font installer is
here, configuration of mouse and
keyboard, device preferences for
audio and video, and setup and

configuration if you have something that runs
remotely using infrared.
We can do many things in KDE Control Center.
Hopefully, its changes will make things easier to find,
once we get used to them.
Enjoy!!

KDE Control Center's New Look

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

http://pclosmag.com
http://twitter.com/iluvpclinuxos
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by Meemaw
I recently made the
switch to KDE4,
and was greeted
with a new file
manager called
Dolphin. While I
have used
Konqueror for
almost four years, I
decided I'd try
Dolphin while still
using Konqueror. I
wanted to see just
how much they
differ, rather than
just deciding there
was something
wrong with Dolphin, just because it didn't look
exactly like Konqueror. After
using them both for about
three weeks, I've found that
they are actually much more
alike than one would think.
If you open Konqueror, then
open Dolphin right next to it
you should see basically the
same thing.The arrangement
of each window is pretty
much like the other, and the
default location that opens is
your /home folder. Default in Dolphin is single­click
to open a file, but you can change it if you wish. (If I
remember correctly, it was that way in Konqueror as
well, but I'm used to double­clicking, so I changed
mine.)

So, now let's compare:

In Dolphin, these three items can be toggled on and
off in View > Panels, and can be placed at the left or
right side of the window, or even stacked on top of
each other with tabs for each one. I have Information
on the right and Places and Folders on the left (tabs

at the bottom.)
However, the two file
managers can be
configured to look
almost exactly alike if
you wish.
The Location bar is
just a little different.
In Konqueror, it is in
the toolbar to the
right of the buttons;
in Dolphin it is a little
more hidden, being
just above the view
window where your
home folder is
displayed.

You can do something in Dolphin's location bar that
you can't in Konqueror. Say you are looking for
something in /usr and have gone 'in' several folders.
Now look at your location bar in Dolphin. It shows
the path you are on (just like in Konqueror).
However, maybe you think it's back up the tree in
another folder, but you don't want to lose this
location. Go to your location bar and click on the
arrow to the right of the directory you think you want.
You'll get a drop menu of the folders under the
location bar, and you can see if the one you are
looking for is there. (Notice the one you are in is in
Boldface.)

KDE 4: Dolphin or Konqueror?KDE 4: Dolphin or Konqueror?
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Split View is
possible in both
Konqueror and
Dolphin. In
Konqueror, it is
under Window >
Split View. In the
default setup of
Dolphin, there is
a button on the
toolbar.

Tools ­ The two main tools are 'Find File' and 'Open
Terminal' and are present in both file managers.
However, in Dolphin you can open a terminal within
the Dolphin window as well. Simply go to View >
Panels and choose Terminal.
Bookmarks: each program can use Bookmarks.
There are three types ­ web bookmarks, places and
application.

Web bookmarks are used by Konqueror when it is
being used as a web browser.

Places (both applications use these) are usually
only those places on your system
you access regularly or want to
remember ­ like the Places menu
in System. You can right­click a
folder in Dolphin, choose "Add to
Places," and it will be added to
the places menu. (I added my
Magazine folder to Places.) ­­­>

Application bookmarks can
be accessed from any KDE
application, if you wish. If you
store all the photos you took on
your trip in a single folder for use
in Gwenview, for example, you
can bookmark that folder. It is

then available in any other KDE program. You first
have to enable bookmarks in one of the KDE
programs.

There are a couple of neat little features in Dolphin
you might like. Hover your mouse over a file or
folder... see that plus sign? It allows you to select
that item. Now do it again with another item... you
can select as many files or folders as you wish (in
case you want to move some things around.) We've
always selected multiple files by holding down CTRL
and clicking away, but this method works too. If you
select one by mistake, you can go back to it and
click the minus sign that's there now and Dolphin
will remove it from the selections.

Also, see that slider at the
bottom of the window? You can
change your icon size just by
sliding the slider to the right. I

like it because it's right there and I don't have to go
into the menu at all (Lazy? Probably!!!)

KDE 4: Dolphin or Konqueror?

Above ­ Back through the tree Below ­ Split view
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There's much more, but this will get you started. I
found that either of the file managers works equally
well, plus there are a few extra things that Dolphin
can do.
You can also visit
http://userbase.kde.org/Tutorials/File_Management#
Discover_Dolphin
for KDE's Dolphin tutorial.

KDE 4: Dolphin or Konqueror?
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by Andrew Strick (Stricktoo)

In this article, I will take a very cursory look at
tinkering with the settings in Dolphin, the default file
browser for KDE 4. As a caveat, I do mean cursory. I
will not be going into much depth because most of
the options are quite straight forward, which makes
explaining them more confusing than helpful. If you
really want to get to know Dolphin, your best bet is
to simply start playing around with various settings
until you're satisfied with the result. So, with that in
mind, let's get started!
The first thing that we'll need to do is open the
Settings dialog. We can do this by clicking on
Settings > Configure Dolphin in the menu bar.
This will open the Settings dialog, specifically the
Start up tab, where you can modify the way Dolphin

looks when first launched. By default, Dolphin
displays your Home (/home/[username]) folder. This
can be changed by editing the location displayed in
the Home Folder text box.
If you check Split View Mode, Dolphin will launch
with two panes displayed. Editable Navigation Bar
switches the navigation bar from navigation mode to
the more traditional browser­style textbox. Show full
path inside location bar causes the navigation bar
(in navigation mode) to display
“/»Home»[username]” instead of simply “Home.”
The next option, View Modes, is where you can
tweak the way Dolphin displays your files. The
settings for each viewing mode (Icon Mode, Column
Mode, and Detail Mode) are on individual tabs. Each
viewing mode has its own set of Icon Size sliders.

The first slider, Default, increases or decreases the
size of normal Dolphin icons. The Previews slider
has the same effect, but on previews. That is, you
won't notice any change unless you toggle previews
on via that Previews button on the main toolbar.

On the Icon Mode tab, the Text area contains
allows you to select a specific font for icon names.
Number of lines refers to the number of lines onto
which icon names will break, if they are too long to fit
in the text area. You can set the size of that area
using the Text width option. In the Grid area, the
arrangement setting gives you the option to have
Dolphin display icons in columns instead of rows,
and Grid Spacing controls the amount of space
between icons.
The Navigation tab only has four options. The first
two control allow you to toggle between single and
double clicking to open files.

KDE 4: A Brief Look at Configuring DolphinKDE 4: A Brief Look at Configuring Dolphin
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If you select Open Archives as Folders, clicking on
an archive (files with extensions like “.tgz” or “.zip”)
will open that archive in Dolphin instead of Ark. As
for Open Folders During Drag Operations... Well, I
haven't been able to discover what exactly this
option does.

Next, the Services tab is essentially a list of every
option that might appear in a context menu (e.g.
Right Click » Open With). If you have unused
options cluttering up your context menus, you can
come here to deselect them. And no, Dolphin
unfortunately does not (yet) have a method for
adding options to this list.

The Trash tab contains options for controlling the
size of your Trash folder. You can set Dolphin to
automatically permanently delete files that are older
than a specific number of days, as well as limit the
size of your trash folder (as a percentage of your
total /home partition size) and tell Dolphin what to do
when you hit that limit.

And finally, there's the General tab, which contains a
host of miscellaneous options. Most are clearly
labled, so I won't muddle things by trying to to
explain them, but there are two things that I would
like to point out. First, the Rename Inline option
under the Behavior tab is incredibly useful. If you
enable it, file extensions will no longer be
automatically selected when you rename them. This
is probably seems fairly inconsequential, but it does
come in handy when you are attempting to rename a
large number of files at once, because you can
simply type out the new name instead of having to

KDE 4: A Brief Look at Configuring Dolphin
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scroll to the beginning or end of the old name to
avoid deleting the extension. Second, enabling a file
type in the Previews tab will cause Dolphin to
automatically enable Previews whenever you open a
directory containing that type of file. For example, if
you check “JPEG”, whenever you open a folder that
has JPEG images in it Dolphin will toggle Previews
on (and the Preview button on the main toolbar will
be depressed).

One last thing that I would like to do is explain the
search function in Dolphin. If you right click on the
main toolbar, or go to Settings > Toolbars, you can
elect to display the Search toolbar next to the main
toolbar.

However, if you attempt to search for a file, you'll
receive an error message telling you that
nepomuksearch (the KDE 4 indexing service) failed.

This is because you first need to enable indexing.
And to do this, you need to go to Configure Your
Desktop > Advanced User Settings > Desktop
Search and enable both Nepomuk and Strigi.

Once enabled, Nepomuk and Strigi will begin to
index your home folder, and you will be able to use
the search bar to locate files.
WARNING: indexing can take time. I would suggest
going to the Advanced Settings tab and
deselecting any directories that you do not need

indexed, especially if they contain large numbers of
image or video files. Also, you can pause indexing
by right clicking on the Nepomuk icon in the system
tray and clicking Suspend Strigi Indexing.

While this article was very brief, I hope that it helps
to make the transition to Dolphin a little bit smoother.
But if in the end you simply cannot get used to
Dolphin, never fear: Konqueror can still be set as the
default file browser in KDE 4. Simply right click on
any folder, select “Properties” and click on the small
wrench icon on the right side of the screen. This will
open the file properties dialog for directories. Move
Konqueror to the top of the list and hit “OK.” It's just
that simple.
(See images on next page).
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by Paul Arnote (parnote)
Windows users call it the "taskbar." To Linux users,
it's called the "panel." The panel has been around for
a long time. Many of us are accustomed to how the
panel worked under previous versions of KDE, such
as KDE 3.5.x. Most of the functionality we had
become used to in previous versions of KDE is still
there, with some new features added in to improve
functionality.
Under the previous versions of KDE, the panel was
under control of a separate module that ran in the
background and managed the panel. Under KDE 4,
the panel is simply another widget/plasmoid running
on the KDE 4 Plasma desktop. Since it is a widget,
you must first unlock the widgets, by selecting the
cashew in the upper right corner of the screen, and
selecting "Unlock Widgets" from the cashew's menu
that pops up. Alternatively, you can right click your
mouse anywhere on the desktop, and select "Unlock
Widgets" from there.
Once your desktop widgets are unlocked, you will
then see the cashew on the panel, in the lower right
corner of your screen (provided your panel occupies
the default position, at the bottom of the screen).

Clicking on the cashew on the panel (previous
column, right lower corner) will reveal the more
common settings for the panel widget, and allow you
to change the way the panel is laid out.
Before we start changing things around, it's probably
a good idea to learn where things are placed, by
default.

Starting with the first one­third of the panel, the first
item (from the left) is the KMenu, which as in
previous versions of KDE, gives you access to the
GUI versions of the programs installed on your
system. The next seven icons represent launchers
and other widgets installed on your copy of KDE 4.
The first of those is the Device Notifier, which
provides access to the various storage devices you
may choose to use with your computer. These may
be USB Flash Drives, USB External Hard Disk
Drives, or even blank, recordable optical media. The
next icon, from left to right, is the "Show Desktop"
widget. Clicking on this will cause any and all open
windows on your workspace to be minimized to the
panel. The larger wrench and screwdriver icon
represents "Configure Your Desktop" (previously
known as KDE Control Center, or KCC), where you
would go to make changes in the behavior of your
desktop. The next icon, with the wrench and
screwdriver in the blue circle, brings up PCLinuxOS
Control Center, a.k.a. PCC, which is where you
would go to configure various things related to your
computer's configuration, and how PCLinuxOS runs.
The box, CD and floppy disk icon launches Synaptic,
for installing/removing items from your installation of
PCLinuxOS. The "file cabinet" will launch the

Dolphin, the default file manager for KDE 4. The last
icon launches Firefox, and is not there by default. I
added it to the panel, since I use it so often.
Lastly, at the far right of the first one third of the
panel, is the pager widget. This represents the
various workspaces, or desktops, available on your
installation of KDE 4.
The middle one third of the panel holds the icons of

your currently running programs. Here, I have
Dolphin, Firefox and XChat running. The icons are
arranged alphabetically on the panel, making it
easier to find the program you want to switch to.
The last one third of the panel holds, first, the

system notification area. This area is where you will
find the Klipper Clipboard Tool, your KMix volume
control, net applet notification of your network
connection, and notifications from select other
programs you may have running. Here, I have
Dropbox, checkgmail and XChat running in the
system notification area. The icon with the lower
case "i" in it will inform you of system messages as
they occur.
The next item in the last one third of the default
panel is the battery monitor widget, so I can monitor
the charge status of the battery in my laptop. To the
right, is the clock display. To the right of the clock, is
the Lock/Logout widget. The top (blue) button allows
you to lock your screen, while the bottom (red)
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button provides all the options for shutting down
your system, when selected. Finally, at the far right
is the cashew that, when selected, will pop up the
common configuration options for the panel widget.
The first configuration option (from the left) is which
screen edge you want your panel displayed on.
Simply click on "Screen Edge," and while holding
down the mouse button, drag the panel to the
screen edge you want it on.
Clicking on the "Height" button allows you to change
the height of the panel. Just click on "Height" and
drag your mouse (while still holding down the mouse
button) to set the height of the panel.
If you would like to add some widgets to either the
desktop or the panel, click on the "Add Widgets..."
button. When you do, all the currently installed
widgets will be listed in a horizontally­scrolling list,
just above the panel. Double click your mouse on

the widget you would like to install, and that widget
will be added to either your desktop or panel. You
can close the "Add Widgets" bar by clicking on the x
at top right. We'll talk more about widgets in greater
detail in another article that deals only with widgets.
Back in the configuration bar, the "Add Spacer"
button will add space between elements that are
placed on the panel. The "Lock Widgets" button will
lock the widgets to their current position, and not
allow the addition or deletion of those widgets until
widgets are (again) unlocked, as mentioned near the
beginning of this article.
When you click on the "More Settings" button, you
will get a pop­up menu. From this menu, you can
tune the appearance of your panel. At the top of this
menu, you can determine if the panel is aligned with
the left or right side of your screen, or if it is centered
between the left and right borders of the screen. You
can also select the visibility options. This includes if

the panel is "Always visible,"
set to "Auto­hide," if
"Windows can cover" the
panel, or if "Windows go
below" the panel. If you
select the "Maximize Panel"
option, then the panel will
expand to fill the entire
border that you have
assigned to it. It is here,
under the "More Settings"
option, that you can also
remove the particular panel
that is associated with the
"More Settings" menu item.

Fine Tuning The
Appearance Of Your Panel
The things that we have covered so far involve the
appearance of your panel as it exists on a full
installation of PCLinuxOS 2010. There are other
options available to help fine tune the appearance of
your panel.
Not everyone cares to have the panel maximized to
fill the border assigned to it. It is while you have the
panel options activated that you can set the width of
the panel. At the far left of the panel, just above the
"PC" KMenu icon, is a down arrow. Clicking and
dragging this arrow with your mouse will set where
you want the edge of the panel to be. At the far right

KDE 4 Panel Configuration Options
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side of the panel, just above the cashew, you will
see a "+" and a "­" sign. Click and drag the minus
sign to set the minimum size of the panel, and click
and drag the plus sign to set the maximum size of
the panel. You can again quickly make the panel fill
the entire border edge assigned to it, simply by
selecting the "More Settings > Maximize Panel"
option.
Just as everyone has differing views on how wide to
make their panel, not everyone wants to have the
panel arranged the same way. When the panel is
unlocked and in the panel options mode of display,
simply place your cursor over any item or element of
the panel. You will see the cursor change to one with
four opposing arrows. By clicking and dragging your
mouse, the item under the cursor will be moved to
whatever position you choose. Simply release the
mouse button when you have the item placed where
you want it. For example, we can place the "move"

cursor over the pager widget, and move it from its
default position after the launchers, all the way to the
right side of the panel, between the clock and
Lock/Logout widgets.
As I mentioned earlier, the Firefox icon is not
present, by default, on the panel. I added that, since
I use Firefox so often, and since I want quick, easy,
one­click access to launching Firefox when I need it.
You can do this with any program icon that appears
in your KMenu. Simply right­click your mouse on the
item (as it appears in the KMenu), and select "Add
To Panel" from the pop­up menu. This will place a
launcher on your panel, although not necessarily
where you might want it. If it isn't inserted where you
want it (my Firefox icon initially was added next to
the System Notification widget), simply use the
previous instructions on how to move it where you
want it. In my case (with the Firefox icon), I moved it
to the right of the icon for Dolphin.
You can further tailor your panel's appearance to suit
your tastes by going into "Configure Your Desktop"
(a.k.a., KDE Control Center). Under "Look & Feel »
Appearance » Style," go to the "Workspace" tab.
From there, you can set the KDE style. The default
style on the PCLinuxOS 2010 installation is
"Glassified." You can also choose from "Air," "Air for
netbooks" or "Oxygen." You can also download
additional themes from http://www.kde­look.org, and

install them for your use. Just go to the
Themes/Styles section, and be sure you are in the
KDE 4 section.
There is yet another customization you can make.

Although it isn't directly related to configuring your
panel, it is worthy of including here. The default
installation of PCLinuxOS 2010 comes with 4
multiple desktops (a.k.a "virtual desktops" and
"workspaces") pre­configured. But some users want
to have more workspaces. Some users are known to
have as many as 20 (yes, twenty) workspaces.
Some users are at the other end of that spectrum,
and use only two. By going into "Configure Your
Desktop," and moving to "Look & Feel," "Desktop"
and "Multiple Desktops," you can select the number
of desktops you want to have available to you, and
displayed in the pager widget.
Some users like to have different wallpapers
displayed on each different desktop. It is here where
you can select to have a "Different activity for each
desktop." Under Plasma in KDE 4, you apply
"activities" to your desktop. The wallpaper is but oneKDE 4 Panel: Moving objects with widgets unlocked. Note the 4­way cursor.
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component of that activity. Other components
include the various widgets. As such, by selecting to
display a different activity for each desktop, each
desktop activity becomes a stand­alone activity that
is applied to the assigned desktop. This means that
if there is a widget that you wish to be displayed on
every desktop, and you have KDE 4 set to display a
different activity on each desktop, you will have to
re­add that widget to each desktop activity, and run
that widget as many times as you have number of
desktops. Currently, there is no way to separate the
wallpaper from the desktop activity, and have a
different wallpaper on each desktop, while running a
common set of widgets across all desktops.
Numerous pleas to the KDE 4 development team for
this feature have gone mostly ignored.
It is also here, in "Configure Your Desktop," that you
can (if you wish) assign names to your desktops. For
example, instead of the default "Desktop 1,"
"Desktop 2," and so on, you may want to call your
four default desktops "Earth, Wind, Fire, and Air,"
respectively.

Conclusion
As you can see, there are quite a few configuration
options for the new panel widget in KDE 4. Let your
imagination run wild. Play with the configuration
options, and come up with a custom panel
configuration that's exclusive to you and best fits
how you work and interact with KDE 4.
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by Paul Arnote (parnote)
By now, anyone who uses Linux has heard of the
new KDE 4. The KDE developers no longer call "it" a
desktop environment, or DE. Nope. Now, it's known
as KDE SC, or Software Compilation.
One of the cornerstones of the new KDE 4 SC is
Plasma. In fact, Plasma is your desktop. It's
everything you see on your screen when you start
up KDE 4. It's the panel(s), the desktop, application
launcher – the whole she­bang.
Plasma is a whole new way of looking at the
desktop. Sure, you can make it look like and have
virtually the same functionality as the KDE 3.5.10
desktop. But then, you'd be missing out on some of
the new features that Plasma delivers. So, let's take
a look at Plasma, how it changes the desktop
metaphor, and the things you can do with it.
At right is what a typical Plasma desktop looks like.
There are three principal components of a Plasma
desktop. They are: the panel (often referred to as the
"task bar," and defaults to the bottom of the screen),
the desktop (the area occupied by the wallpaper and
where any Plasma widgets are placed), and the
Plasma toolbox (represented by the "cashew" in the
upper right corner of the screen).
You use Plasma just as you would any other desktop
on most any other computer operating system. You
launch your programs from the KMenu, you view the
currently active programs in the panel, access
programs from the panel tray, etc. Much of that is

just as you have become accustomed to while
running the previous versions of KDE.

An important part of Plasma is the widgets, also
called plasmoids. Widgets are individual parts of the
desktop metaphor. They can include, but are not

KDE 4: Introducing PlasmaKDE 4: Introducing Plasma



27

limited to, the panels, the clock, the system tray,
icons and folders, weather forecasts, the trash can,
photo slide shows – the sky is the limit, limited only
by the imagination of the widget authors. In fact,
panels and desktops are widgets, who's job it is to
contain other widgets. In Plasma, these are called
"containments."

The key to using widgets is the Plasma
toolbox, commonly referred to by many
simply as the "cashew." From the cashew,
you can add or delete widgets from your
desktop or panels, lock the widgets, or

several other functions. You will also find the cashew
on some widgets, as well as some panels (like on
your main panel, usually located at the far right side
of the panel).
One thing you are likely to notice is that there are no
icons placed on the desktop, as many users
sometimes like to do. Rather, icons are placed in a
container, called Folder View. One advantage is that
you can have multiple Folder View widgets on your
desktop, each pointing to a different directory on
your computer. In this way, it makes it easier to
organize your desktop, and to group your icons
together.
Once on your desktop, widgets can be configured
via the widget handle. The widget handle is
displayed when you mouse over the widget, but only
when widgets are unlocked, via the Plasma toolbox
cashew. With the tools on the widget handle, you
can resize the widget, set options for that widget,
move it about your desktop, and delete that
particular widget from your desktop.

Clicking your mouse on an empty part of the handle
will allow you to drag the widget to the desired
location on your desktop. By clicking on the first tool
in the widget handle, you can resize the widget. The
second tool will allow you to rotate the widget. Click
this tool and rotate the widget to the desired angle.
The third tool (the wrench) allows you to access the
configuration parameters for that particular widget.
The last, and bottom, tool allows you to remove the
widget from your desktop.
As surprising as it may seem, not only widgets that
are written specifically for Plasma can be used, but
you can also use widgets created for Google
Gadgets and Dashboard Widgets from Mac OS X.
These may be installed from "Get Hot New Stuff," a
KDE module scheduled to become a part of the KDE
libraries (kdelibs).

Plasma also brings a new way to work with your
desktops with something called activities. Activities
allow you to define different widgets (and
wallpapers) to each of your virtual desktops. There
is, understandably, a limited amount of real estate on
each of your different virtual desktops. As a result,
you may not be able to place all the widgets you
want to use on your desktop, without it appearing
cluttered and crowded. By using activities, and
defining different widgets for each desktop, you can
maximize the placement and use of a greater
number of widgets. You set these activities by
clicking on the Plasma toolbox (cashew), and
zooming out to display all of your desktops on one
screen. Then, select "Use a different activity on each
desktop." That is all you have to do to set up
different activities for each desktop.
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Say that during your "day job," you are working for a
financial consulting firm. On your "off hours," you are
writing the next bestselling novel. You also have a
vast personal photo collection of your kids,
grandchildren, and other significant members of your
family. In your "free time," you are working to learn
packaging. Now, with activities, you can devote each
of your desktops to a particular activity. So, on
Desktop 1 you have all of the files related to your job
with the financial consulting firm. On Desktop 2, you
have all of the files related to your creation of that
next bestselling novel. You can place multiple picture
frames and slide shows on Desktop 3, displaying
your picture collection of those who are dear to you.
And finally, on Desktop 4, you can have all of the
files that are related to your efforts to learn
packaging in yet other Folder View widgets. I think
you should be able to catch on to the idea being put
forth here.
Overall, the KDE developers have made great
efforts to extend the usefulness and flexibility of the
computer desktop. Do you have to use these new
features? Certainly not. There is a setting in KDE 4
SC to change your desktop from one that utilizes
Folder View, to the more traditional Desktop View
that you have most likely become familiar with under
KDE 3.5.10. But, under the Desktop View, you may
lose, to varying degrees, the ability to utilize the
newer features that Plasma brings to the KDE 4 SC
desktop.
After all, Linux IS all about choice.
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From the KDE 4.3 Userbase Plasma FAQ
Reprinted under the

Creative Commons Share­Alike License
Editor's Note: With the impending change to KDE
4.x inevitable, especially since support for KDE 3.5.x
officially ended October 31, 2009, there are bound to
be lots of user questions concerning KDE 4.x, and
the direction that the KDE developers have chosen
for KDE 4 SC. This FAQ goes a long way in
answering many of the questions that KDE 3.5.x
users may have, and may help users making the
transition adapt to those changes quicker. This FAQ
covers up through KDE 4.3.x. KDE 4.4.x is due out
this month, February, and should be applicable to it,
as well. — Paul Arnote, PCLinuxOS Magazine Chief
Editor.

General Questions
What does Plasma do?
Plasma is the desktop interface for KDE SC 4,
including the application launcher (start menu), the
desktop and the desktop panel (often referred to
simply as the task bar). However Plasma is more
than just this familiar collection of utilities, it is a
common framework for creating integrated
interfaces. It is flexible enough to provide interfaces
for mobile devices, media centres and desktop
computers; to support the traditional desktop
metaphor as well as well as designs that haven't yet
been imagined.
What is wrong with the current desktop
technology?

Today's desktops are static. Typically they are tied to
a folder in which one can find icons (application
launchers), or user­placed documents and folders.
Along with pictures and images as backgrounds, the
current desktop doesn't go any further, or work for
the user. Plasma takes a different approach,
engaging the user by creating a dynamic and highly
customizable environment.
I don't think it's such a good idea...
With Plasma, you can let your desktop (and
accompanying support elements) act like it always
did. You can have a task bar, a background image,
shortcuts, etc. If you want to, however, you can use
tools provided by Plasma to take your experience
further, letting your desktop take shape based on
what you want and need.
How does Plasma work?
Plasma's components are widgets called Plasmoids.
Plasmoids can take on a variety of functions,
ranging from displaying your desktop and associated
wallpaper, showing your laptop's battery level,
displaying your plugged in devices, and drawing the
taskbar: basically, they are small applications that
live on the desktop. Plasmoids can be grouped
together in "containers" called containments. On a
default desktop, there are two main elements: the
Panel and the desktop itself. Both are containments
in the Plasma sense.
It doesn't sound too new... other operating
systems have done that.

The key difference here is that plasmoids can
interact together. You want a better view of your
laptop battery in order to find out when you are
running low? You just drag it away from the taskbar
and put it on the desktop. Also, applets can be
resized and rotated at will, thanks to the use of
Scalable Vector Graphics (SVGs). As you can see,
the desktop not only interacts with you, as the user,
but also with itself in new and interesting ways. You
are now able to control how your workspace
behaves and what it displays, in a visually pleasing
and user­friendly manner.
Since Plasma is the sum of its plasmoids, every
element, even the desktop itself, is a widget. This
allows you to move your desktop anywhere with
respect to the windows (back and forward). It is no
longer rooted behind everything and becomes
instead another element of real interaction.
Kicker and Kdesktop were working fine in KDE 3.
Why did you have to change that?
Especially regarding kicker, there was the important
issue of maintainability. The code was in place since
the KDE 2 days, and it was difficult to add new
features without breaking others. In the end, to
proceed forward the only viable option was to start
anew from scratch.
I can't find my favorite <insert feature here>!
Don't forget that the Plasma Desktop is still in heavy
development and that KDE 3 was an extremely
polished codebase: it took seven years to get to that,
while Plasma is much younger. With time, the
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Plasma developers plan on reintroducing features
that are missing and fix regressions. As it progresses
through the KDE SC 4.x cycle, Plasma will improve
with it.
Why was the way the desktop operates
changed?
The idea of a Desktop folder is fundamentally a
broken concept. It assumes that everything you will
access there resides on a single physical directory
on your disk. It may be convenient, but at the same
time it greatly limits what you can do. For example,
you can't use custom layouts for different desktops,
as everything would be read from the directory. Also,
quite often a desktop structured like that becomes a
dumping ground for files and folders, without any
other function.
I heard there are no more icons on the desktop...
That is not entirely correct. You can have icons and
launchers (shortcuts) by dragging them from Dolphin
or the K­menu. What has changed is that the
desktop will no longer display the contents of the
Desktop folder. However, you can show an arbitrary
number of folders (local or remote) on your desktop
view, instead of being forced to display only the
contents of the "Desktop" folder. To do so, the Folder
View applet comes into play.
Also, should you wish, you can replicate the "icons
on desktop" paradigm with minimal effort.
What is the Folder View applet?

The Folder View applet, like its name says, is used
to display items (folders, files) from a directory. Such
a directory can be either a local one residing on your
computer, but also a remote FTP, SSH, or SMB
share. In the future, it will even contain results from
Nepomuk searches and tagging.
You can choose to view either all files, or filter either
by specific regular expressions (e.g., all files with a
certain extension) or by file type (for example, just
images).
This applet also supports basic file management
properties (moving, copying, cutting and pasting for
example), and you can have as many as you want
on your desktop.
Lastly, you can use one Folder View as the whole
desktop, effectively replicating the "old style"
paradigm.
What's the deal with Kickoff (the new K Menu) ?
During the development of KDE 4.0, different
approaches for a K menu (application launcher)
were tried. Some projects were ambitious but there
was no way they could be completed on time. At the
time, one developer ported SUSE Linux's application
launcher (Kickoff) to the new KDE desktop
architecture. As it was the most ready and feature
complete (not to mention the product of usability
testing) it was chosen to be the default menu. If you
don't like it, the traditional K­menu is available as
well ­ right­click onto the K Menu to find an option
"traditional style". Also, some alternative menu
systems have been announced and some, such as

Lancelot, are ready for daily usage and offer exciting
new features.
What is KRunner?
KRunner is the versatile mini­command line you can
activate by pushing "Alt­F2" or by selecting "Run
Command" from the desktop contextual menu. It can
search for applications, bookmarks, even sessions
basing on your input, show system activity and even
do simple arithmetic calculations.
KRunner's functionality can be extended through the
use of plugins ("runners").
What are the "cashews"?
What is commonly referred as "cashew" is the
Plasma logo you can find on the default desktop, on
the upper right corner, and on the panel, on the right
hand side (left hand side if you use a Right­To­Left
language). By clicking on them, you can access
other configuration options, such as panel
configuration and the Zooming User Interface (ZUI).
Some of these, like the panel cashew, only appear if
the widgets aren't locked (see below).
Please provide an option to disable the upper
right cashew.
Although putting an option to disable the cashew for
desktops sounds reasonable, from a coding point of
view it would introduce unnecessary complexity and
would break the design. What has been suggested
is, since the desktop itself (a containment) is
handled by plugins, to write a plugin that would draw
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the desktop without the cashew itself. As a matter of
fact, some distributions ship already a "Desktop
without cashew" plugin.
What is the Zooming User Interface (ZUI)?
The Zooming User Interface, or ZUI, is another
component of Plasma. It enables the user to group
different groups of plasmoids together, and to quickly
switch between one and another using a zoom­and­
pan approach. Notice that at the time, although
significant improvements have been made, this
feature is still under heavy development and may be
fully functional only with later KDE SC 4.x releases.

How does the ZUI work?
Suppose you have three groups of plasmoids (such
as widgets, application launchers, etc.) which you
want arranged in specific combinations depending
on what you want to do. You first group them
according to your tastes, then you can switch
between them by zooming out (getting a preview of
all the groups) and then back in on the specific
group you want to use. Notice that it is different from
traditional X11 virtual desktop switching, as there is
a higher degree of flexibility by using this approach,
as the groups can be totally different from each
other.
A very good example of this behavior is shown by
this image courtesy of Half­Left from #kde on
freenode.

That said, you can tie virtual desktops to ZUI
activities.
Why can't I use the ZUI from Dashboard view?
That feature is a work­in­progress. We're looking
into it, but can't yet say how and when it will be
finished.
On multi screen setups, the ZUI operates on all
screens, the Dashboard just on one. Why is that?
The workflows are different. When zooming out, the
user wants to get an overview, therefore activities on
all screens are zoomed out. Whereas when using
the Dashboard, the user usually wants to access
specific functionality and might not want to interrupt
his or her workflow on other activities.

Configuration
Can I place icons on the desktop?
Of course you can. Dragging an icon from Dolphin or
Konqueror to the desktop will work. Notice that
dragging on the desktop will not actually create a file
there, just a link to it.
To display the contents of your Desktop folder, or
any other folder, use the Folder View applet.
Alternatively, right­click on an empty area of the
desktop, select "Desktop Settings" and in the dialog
that will pop up locate the "Desktop Activity" text.
Click on the "type" combo box and select "Folder

View". Click OK and you will have a Folder View
applet as desktop (showing the contents of the
Desktop folder by default), like the "old style"
paradigm.

If your widgets are locked, you must
first unlock them, using the right­click
menu.

I am using two screens, and I used to have
kicker over the two displays. Can I do that with
Plasma?
No. The reason is that having a panel over two
displays adds a great deal of complexity, especially
when the two displays have different resolution. As a
result of this added complexity, this feature would
not be guaranteed to work in all cases, hence it was
not implemented.
Can I put the panel on only one screen?
All Plasma panels live in one screen. If you want
panels on multiple screens, you can add panels and
drag them to your preferred location using the panel
controller you get when clicking on the Plasma icon
in "Unlocked" mode.
How can I add applets to the panel?
Method 1: Open the Add Widgets dialog in the
Plasma cashew (upper right corner of the screen)
then select the widget of your liking and drag it
directly (don't double click or use the Add Widget
button) to the panel.

TIP
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Method 2: Drag an applet from the desktop to the
panel.
Method 3: Click on the cashew on the panel, and
select "Add widgets". Once you have selected the
applet, it will be automatically added to the panel.
Can I move the applets on the panel?
To do so, open up the panel controller (by clicking on
the cashew or by right clicking on the panel and
selecting "Panel Settings") and hover the mouse
cursor over the applets. Its shape will turn into four
arrows, and you'll be able to rearrange the applets
as you wish.
Lydia Pintscher's blog has a video showing
movement in action. Another one is available on
Aikurn's blog. Aikurn has also made an annotated
video.
How can I change the height and the size of the
panel?
Click on the panel cashew (the small icon on the
right side of the panel) to open the panel
configuration interface. By clicking on "Screen
Edge", you can position the panel on any of the
edges of the screen. Clicking on height and dragging
increases or decreases the size of the panel.
The arrows on the sides of the panel define its size:
there are two, which define "minimum" and
"maximum" sizes. The maximum size is the size at
which the panel can expand when items are added,
while the minimum size is the minimum size the

panel can have. If they are set differently, the panel
will readjust its size depending on the contents.
Under "More Options" there are additional options to
align the panel and configure its behavior.
Can I auto­hide the panel?
Open the panel controller, select "More Options",
then click on the relevant option.
How can I remove a panel?
Click on the panel cashew, click on "More settings",
then select "Remove this Panel". Alternatively you
can right click on the panel itself, select "Panel
options" and choose "Remove this Panel".

General Panel Configuration Help
This forum page gives an illustrated guide to
configuring the panel.
I heard that you can use OS X's widgets with
Plasma. Is this true?
Yes, Plasma can use OS X's widgets. Work has
been done to implement also Javascript­based
widgets (reverse engineered due to Apple's license).
How do I move, rotate or resize an applet on the
desktop?
First of all, hover over the applet you want to resize.
The applet handle will appear.

The applet handle takes care of resize, rotate and
move.
* To move an applet: Click on the handle, then drag
the applet around.
* To rotate an applet: Click on the curved arrow then
drag to rotate
* To resize an applet: Click on the square icon and
then drag to resize the applet. You can constrain the
resize operation to the applet's aspect ratio by
holding down the Ctrl key.
My widgets are hidden under the windows. How
can I show them?
You can bring all the widgets to the front by pushing
Ctrl­F12, which will bring the Plasma Dashboard to
the front. When you are done, you can either push
the Esc key or select the "Hide Dashboard" option
from the cashew.
How can I lock the positions of the widgets?
Method 1: Right click on an empty area of the
desktop and select "Lock Widgets" from the
contextual menu. If you want to reverse that, right
click again and select "Unlock Widgets". The same
option is available if you right­click on the panel.
Method 2: Select "Lock Widgets" from the Plasma
cashew on the upper right corner or from the panel
controller.
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How do I remove widgets?
If they're on the panel, right click on the widget and
select "Remove this...". If the widgets are on the
desktop, you have different options:
* If you hover over them, clicking the X on the applet
handle will remove them;
* If you use the Add Widget dialog, you can click on
the minus symbol icon next to the widget name to
remove it.
How do I switch between Kickoff and the old
style menu?
Right click on the menu icon and select "Switch to
Classic Menu Style" (if using Kickoff) or "Switch to
Kickoff Menu Style" (if using the classic menu).
Alternatively, you can add either type of menu using
the Add Applets dialog.
Aikurn has a video showing how to switch between
the different styles.
How can I add/remove an activity?
Adding an activity: Zoom out from your current
desktop view by clicking on the desktop view
cashew (the icon in the top right corner) and
selecting Zoom out. You see a toolbar under your
current desktop. Click on "Add Activity" to create a
new desktop view.

Removing an activity: Zoom out from your current
desktop view and select the red cross from the
toolbar that will appear to remove the activity.
Note: You must Unlock Widgets (Ctrl+L) before you
can remove any activities.
KDE Forums user Fengshaun has made a
screencast showing ZUI usage.
How can I quickly move between Activities?
The ZUI method is rather slow, so a better way is to
use an Activity Bar. A short how­to here explains
exactly what you need to do.
Are there any keyboard shortcuts for Plasma?
In addition to the mouse, there is a number of
shortcuts available:
* Lock widgets: Ctrl­L
* Zoom out: Ctrl­ ­
* Zoom in: Ctrl­ = or Ctrl­+
* Next applet: Ctrl­N
* Previous applet: Ctrl­P
* Add activity: Shift­Ctrl­A
* Next activity: Shift­Ctrl­N

* Previous activity: Shift­Ctrl­P
* Applet settings: Ctrl­S
* Remove applet: Ctrl­R
To change shortcuts, click on the desktop cashew
and select "Shortcut settings".
How can I associate a keyboard shortcut with an
applet?
Simply select an applet's settings (the wrench icon
on the applet handle) and then click on "Kyeboard
Shortcut". You will then be able to define a keyboard
shortcut for your applet. Notice that some applets do
not offer this feature (generally the ones that have
no configuration).
Can the Dashboard show widgets other than
those on my desktop?
Yes, it can. To configure it, click on the desktop
cashew and zoom out. Choose "Configure Plasma"
from the toolbox that it appears, and check the "Use
a separate dashboard" option. Click on OK and you
will have a different dashboard than your desktop
when you access it.
How can I use virtual desktops as activities ?
Zoom out by clicking on the desktop cashew and a
new toolbox will open. Click on "Configure Plasma"
then check the box "Different activity for each virtual
desktop". Click on OK and you are done.
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Notifications take up too much screen ­ can I get
rid of them?
For those who do not like it, there is a simple way to
disable them. Right click on the system tray
notification area (the "i" icon) and select "System
Tray Settings".
There you will have the options of disabling
notifications for applications or for jobs (such as file
transfers) by unchecking the relevant check boxes.

Theming
I don't like the default look of the panel and other
Plasma components. Can I change that?
Yes, the ability to change the look of Plasma was
planned since the beginning. Plasma can use
"themes", which are essentially a number of SVG
images and files specifying the colors, to change its
appearance. A number of themes are already
available on kde­look.org.
How can I change my Plasma theme?
Right click on your current desktop, select "Desktop
Settings" (alternatively, you can select the same
option from the desktop cashew) and you will find
the option under "Desktop Theme". You can also
download new themes directly from there by clicking
the "New Theme" button, using Get Hot New Stuff
(GHNS).

Step by step instructions, although made for KDE
4.1, (including screenshots) are available on Aikurn's
blog.
Is there support for advanced visual effects
(transparency, etc.) without using compositing?
In an effort to keep the codebase clean of
workarounds (if not even hacks), the Plasma
developers have decided that features that require
compositing to work will not have a composite­less
version. The main reasoning is that in the past (KDE
3.5.x), such approaches were one of the causes of
the unmaintainability of the code, and also because
supporting those features is actually pushing
graphics card developers to write better graphics
drivers.

Troubleshooting
Plasma crashed, how can I bring my desktop
back?
Normally Plasma automatically restarts in the event
of a crash. If this doesn't happen, open KRunner by
pushing Alt­F2 (it should be still running) and type
"plasma­desktop". Plasma will be restarted.
My panel is gone, how do I get it back?
kquitapp plasma­desktop; rm$KDEHOME/share/config/plasma­desktop­appletsrc; plasma­desktop

This deletes your plasma settings, so you'll get the
default configuration back. If running the 3
commands at once doesn't work, try typing them in
manually and wait a few seconds before running the
next command.
(Note that the $KDEHOME environment variable
may not be set. Try ~/.kde (Fedora, Kubuntu
Intrepid, Debian, upstream default) or ~/.kde4
(OpenSUSE, Kubuntu Hardy and several others).)
Some GTK+ applications show wrong system
tray icon sizes.
That is unfortunately a problem in the
Freedesktop.org system tray specification, which
does not define the sizes for system tray icons
properly.
I experience extreme slowness when using
Plasma with the NVIDIA binary driver.
This is NVIDIA's fault entirely, due to their driver not
supporting correctly the XRender X11 extension, and
it also affects other parts of KDE SC such as
Konsole. See this blog entry on how to report issues
upstream to NVIDIA. This page contains a few
suggestions on how to improve performance.
NVIDIA has released the 18x.xx series driver that
can improve performance dramatically with the
Plasma Desktop and KDE SC 4.x in general.
Users who have a NVIDIA 6 or 7 series card should
add the following lines to their xorg.conf in the
"Screen" section, which may improve performance.
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You don't need to add these lines if you have a 8/9
or above series NVIDIA card, since they're enabled
by default.
Option "PixmapCacheSize" "5000000"Option "AllowSHMPixmaps" "0"
There are some other options you can try, which
may improve things if you get poor Desktop Effects
performance.
Go to SystemSettings»Desktop»Desktop
Effects»Advanced, you will see "OpenGL Options",
make sure "Bilinear" or "Nearest (fastest)" is set as
the "Texture Filter" option. You can also try turning
off "Use VSync" there as well.
Folder View and other plasmoids look badly
rendered with an ATI video card and the open
source radeon driver.
To work around this issue, you have to change the
2D acceleration method from XAA (X Acceleration
Architecture) to the newer EXA. As this involves
editing your xorg.conf file, bear in mind that such a
modification may damage your system. Do it at your
own risk.
To make the switch, edit your xorg.conf file (make a
backup just in case) and locate the Device section
for your graphics card. Add the line
Option "AccelMethod" "EXA"
before the "EndSection" line. If there is already a line
with AccelMethod, change it from XAA to EXA. Save

the file and restart the X server.
Notice that EXA is still marked as unstable, and that
some other applications such as some KDE3
programs may render incorrectly.

Hints & Tips
Add an application launcher to the panel
If you use kickoff as your menu, right­click on the
application icon, and select Add to Panel. If you use
Lancelot simply drag the application onto the panel ­
you may need to hold it there for a second or so
before letting go.
Add a launch menu to the panel
Lancelot makes this possible. Click on the menu
launcher, then drag Applications as described
above. When the popup menu appears, select
'Lancelot part'.
Various parts of the Lancelot menu can be dragged
to the panel in this way. Read this description of how
to use it.
'Favorites' may be a good choice for adding to the
panel
Disabling ARGB visuals
For many of its effects, Plasma makes use of the so­
called "ARGB visuals". For older video cards, this
can mean a severe performance hit. To disable

ARGB visuals and increase performance, you need
to set the KDE_SKIP_ARGB_VISUALS environment
variable to 1 (KDE_SKIP_ARGB_VISUALS=1)
before Plasma starts. You can do so by putting a line
setting this variable in /etc/profile or in ~/.profile.
Right­click the panel when your task bar is full
To make some changes to the panel you need to
right­click on it ­ and if you have open applications
that may not be easy, The workaround for this
problem is to use the panel cashew to bring up the
panel settings, then you can right­click anywhere on
the panel, including on application tabs, and the
command will go to the panel, not the application.
Re­arrange the application tabs on your task bar
Right­click on an empty part of the task bar (or use
the method described above) and select Task
Manager Settings. In the 'Sorting' combo­box, select
'Manual'. 'OK' to close it. Now you can re­arrange
your task icons by holding down Alt and dragging the
tabs to their new order. (If you use this alt­drag while
the panel config panel is open the whole group of
application tabs will move as one.)
Watch some Screencasts
This forum page has links to screencasts that will
help you understand Desktop Settings, Panel
Settings and the Zooming User Interface (a.k.a. the
Cashew).
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Miscellaneous tips
Some alternatives for those who like a sparse
desktop:
1 ­ you can remove the panel entirely. Open
applications would be available using the ALT+TAB
cycling.
2 ­ Remove the panel and add a short one at the top
of the screen, to hold only the task manager
3 ­ Create a panel containing the task manager and
use autohide.
HowTo
A page of Screencasts to help understand Plasma

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...
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by Paul Arnote (parnote)
Under KDE 4, we've heard a lot about widgets, also
known as plasmoids (but we'll stick with calling them
widgets here, for clarity). The panel is a widget. The
system notification area is a widget. The clock is a
widget. The PC menu is a widget. The desktop
pager is a widget. You can even display special
widgets on your desktop, to help monitor the status
of various aspects of your computer, to display
weather forecasts, to display news feeds, to
whimsically bounce a ball around your desktop or
have "eyes" follow your mouse cursor around the
screen. There are, literally, widgets galore in KDE 4.
Before you can add widgets to your desktop, you
must first unlock the widgets on your desktop. You
do this by selecting "Unlock Widgets" from the
cashew's menu in the upper right corner of the
screen, or from the pop­up context menu by right
clicking on the desktop. Then click on the cashew at
the far right of the panel, and select "Add Widgets."
When you do, you will be presented with a selection
of widgets that you can choose to add to your
desktop.

There are a lot of widgets to choose from in the
default installation of KDE 4 in PCLinuxOS. Here is
an alphabetical list of those widgets, with a (very)
brief explanation of what each does. The explanation

comes from the widget itself, whenever possible.
Widgets that are active in a default installation of
PCLinuxOS 2010 are in red text.
Activity Bar: Tab bar to switch between activities.
Analog Clock: Displays a clock with hands.
Application Launcher: Launcher to start
applications.
Application Launcher Menu: Traditional menu
based application launcher (the "PC" menu).
Battery Monitor: See the power status of your
battery.
Binary Clock: Time displayed in binary format.
Black Board: [the function of this is unclear, as it is
not running properly]
Bouncy Ball: A bouncy ball for Plasma.
Bubblemon: A pretty bubble that monitors your
system.
Calculator: Calculate simple sums.
Calendar: View and pick dates from the calendar.
Character Selector: View, select, and copy
characters from a font collection.
Color Picker: Pick a color from the desktop.

Comic Strip: View comic strips from the internet.
Current Application Control: Controls for the
active window.
Device Notifier: Notifications and access for new

devices.
Dictionary: Look up the meaning of words and their
translation into different languages.
Digital Clock: Time displayed in a digital format.
Eyes: XEyes clone.
Fifteen Puzzle: Put the pieces in order.
File Watcher: Watch for changes in specified files.
Folder View: Display the contents of folders. (User's
/home folder displayed by default)
Fuzzy Clock: Time displayed in a less precise
format.
Incoming Message: Notifications of new messages.
Keyboard: A virtual, on­screen keyboard.
KGet Bar Chart Applet: (no description available)
KGet Pie Chart Applet: (no description available)
Knowledge Base: Opendesktop Knowledge Base.
Konqueror Profiles: List and launch Konqueror
profiles.
Konsole Profiles: List and launch Konsole profiles.
KTorrent: Plasmoid to keep track of a single torrent.
Lancelot Launcher: Launcher to start applications.
Lancelot Part: Parts of Lancelot menu on the
desktop.
LCD Weather Station: Weather reports with an LCD
display style.
Leave A Note: Leave notes for others while they are
away.
Life: Conway's Game of Life applet.
Lock/Logout: Lock the screen or logout.
Luna: Display moon phases for your location.
Magnifique: A magnifying glass for the Plasma
desktop.
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Media Player: Widget that can play video and
sound.
Microblogging: Update and view your microblog
status.
News: Show notes from various sources (like the
iluvpclinuxos Twitter feed!).
Notes: Desktop sticky notes.
Now Playing: Displays currently playing audio.
opendesktop ­ Common: Using the social desktop.
opendesktop Activities: Stay informed with the
social desktop.
Pager: Switch between virtual desktops.
Pastebin: Paste text/images to a remote server.
Paste: Paste text snippets.
Picture Frame: Display our favorite pictures.
Qalculate: A powerful mathematical equation solver.
Quicklaunch: Launch your favorite applications.
Remember The Milk: Remember The Milk to­do list
applet.
RSSNOW: Show news from various sources.
Search Box: Search box for a given Runner
Manager.
Show Desktop: Show the Plasma desktop.
Show Widget Dashboard: Show the Plasma
Widget Dashboard above other windows.
Smooth Tasks: Switch between running
applications.
Spell Check: Fast spell checking.
System Load Viewer: Tiny CPU/RAM/Swap
monitor.
System Monitor: System monitoring applet.
System Monitor ­ CPU: A CPU usage monitor.

System Monitor ­ Hard Disk: A hard disk usage
monitor.
System Monitor ­ Hardware Info: Show hardware
information.
System Monitor ­ Network: A network usage
monitor.
System Monitor ­ RAM: A RAM usage monitor.
System Monitor ­ Temperature: A system
temperature monitor.
System Tray: Access hidden applications minimized
in the system tray.
Task Manager: Switch between running
applications.
Timer: Countdown over a specified time period.
Trashcan: Access to deleted items.
Unit Converter: Plasmoid for converting units.
Weather Forecast: Displays weather information.
Web Browser: A simple web browser.
Web Slice: Show a part of a web page.
Window List: Plasmoid to show a list of opened
windows.
yaWP: Yet Another Weather Plasmoid.
If you can't find the widget you are looking for in the
default installation of KDE 4 in PCLinuxOS, or if you
are wondering what's new in the world of widgets,
you can download and install additional widgets from
the KDE web site. Download the widget you want,
and select "Install from local file..." from the menu
that pops up when you click the "Get New Widgets"
button along the top of the widget window that opens
when you attempt to add new widgets. You will
notice that you can choose between five different
widget styles to install: Plasma, QEdje, Google

Gadgets, Mac OS­X Dashboard widgets, or Web
Widgets. Just follow the prompts and select the file
you downloaded. It is highly recommended that you
save any widgets you download from the KDE site to
a special folder in your /home directory, perhaps one
named "widgets."
Or, you can just select the "Get New Widgets"
button, and select "Download New Plasma Widgets"
from the pop­up menu. When you do, you will get a
window similar to the one below.

Once you find the widget you want to install in the
list, simply click on the "Install" button to the right of
the widget description. If you have already installed
a particular widget, the button will change to
"Uninstall" to allow you to uninstall that widget. Don't
expect all widgets you find listed to work properly,
however. In the screen shot, you will notice that the
button to the right of the description for "gmail­
plasmoid" says "Uninstall." This particular widget
would never work for me on my PCLinuxOS 2010
Beta installation (neither Beta 1 or Beta 2).
Your third choice when you select the "Get New
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Widgets" button is to "Install New Google Gadget."
The KDE 4 Plasma desktop has been designed to
easily incorporate Google Gadget widgets, along
with all the ones created and shared on the KDE
site. When you select "Install New Google Gadget"
from the menu, you will get a window similar to the
following screen shot.

This will give you access to over 1,000 additional
widgets, created for Google Gadgets. They work the
same as the KDE widgets on your desktop. And, just
as with the KDE widgets, don't be surprised if you
occasionally encounter a widget that does not work
as expected, or at all. Yet I do have to admit that I've
had fewer issues with the Google Gadgets than the
ones from KDE. Once installed, they generally run
without any noticed problems. One problem that I
did notice was that there were occasional plasma
crashes on my computer when attempting to add
Google Gadgets. However, much to the KDE 4

developers credit, plasma recovered and was fully
functional after the crash. It's more like a "hiccup."
In this screen shot, you
can see the four
widgets that I have
placed on my desktop.
From top to bottom:
System Monitor ­
Network, System
Monitor ­ Temperature,
yaWP, and News. All
four are KDE widgets.
In the "News" widget, I
have the RSS feed from
the "iluvpclinuxos"
Twitter page.
As you can see, it's
easy to customize your
desktop experience
with the addition of
widgets in KDE 4. And,
it's nice that the KDE
development team
embraced the other
"widget platforms" that are currently available by
allowing the use of those other widgets on your KDE
4 desktop. They are incorporated rather seamlessly,
so that it's difficult to differentiate one platform from
another. They just work, for the most part, with only
a few hiccups here and there.

KDE 4: Widgets Galore

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

mailto:pclinuxos.mag@gmail.com
http://pclinuxos.com/?page_id=188
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Reclaim Your Background: the Widget DashboardReclaim Your Background: the Widget Dashboard
by Andrew Strick (Stricktoo)
Introduction
Plasmoids are one of my favorite KDE 4 features. I
enjoy being able to see the weather and my system
stats at a glance. It's helpful to have a notepad
perpetually handy. And I especially love the Folder
View plasmoid, because it allows me to keep
multiple sets of files on my desktop while
maintaining some semblance of organization.
Unfortunately this all comes at a price; after a while
there are too many plasmoids and too little desktop.
Fortunately KDE 4 has a solution: the widget
dashboard.
The dashboard can do two things. It can display all
the plasmoids currently on the desktop over all open
windows. That is, instead of minimizing every open
window, you can see your plamoids simply by
bringing up the dashboard. Alternatively, the
dashboard can display a different set of plasmoids.

Personally, I find this application more useful,
because it allows me to use plasmoids while still
maintaining a clean desktop.
Configuring the Dashboard
The settings for the Dashboard are found at:
Configure Your Desktop > Look & Feel > Desktop
> Workspace.

Unfortunately, the dashboard settings are currently
pretty sparse. “Show Desktop Widgets” simply
displays the plasmoids currently on your desktop
(e.g. Fig. 01). “Show an independent Widget Set”
allows the Dashboard to display a different set of
plasmoids than those currently on the desktop (e.g.
Fig. 03).
Moreover, there is no way (that I can find) to change
the shortcut key from Ctrl+F12. However, “Show
Desktop” can be assigned to a screen corner under
Configure Your Desktop > Look & Feel > Desktop
> Screen Edges.
The Dashboard can also have its own background.

While the Dashboard is active, right click and select
“Desktop Activity Settings” or “Folder View Activity
Settings” from the context menu. From there you can
choose a background image like you would for the
regular desktop. However, if you have compositing
turned on, the Dashboard background will be
transparent and will not display an image.

Fig 01. A very crowded desktop

Fig 02. The settings dialog

Fig. 03. The Dashboard in overlay mode

Fig. 04. The Dashboard without a background
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Reclaim Your Background: the Widget Dashboard

Come
Join Us!

Using the Dashboard
Using the Dashboard is pretty simple. Simply hitting
Ctrl+F12 will bring it up or close it. You can also
close it using the Esc key or by clicking the close
button on the top tab. To add plasmoids to the
Dashboard, (if you are displaying an independent
widget set), right click and chose “Add Widgets” from
the context menu.
Quirks
In using the Dashboard, I've stumbled across a
couple oddities. Neither are major, but they can
cause some confusion.
Oftentimes initiating the configuration dialog for a
plasmoid causes the dashboard to exit. This doesn't
mean that any changes won't be effective; you'll just
have to bring up the Dashboard (again) to see them.
Conversely, bringing up a dialog in another
application does not always cause the Dashboard to
exit. For example, suppose you save a .torrent file to
your Downloads folder. You can add the torrent to
Ktorrent by right clicking on it and choosing “Open
With Ktorrent”. This will bring up Ktorrent's “Add
Torrent” dialog – but it will be under the Dashboard.
However, the dialog will have gained the focus of
keyboard actions, and the Esc key will close the
dialog instead of closing the Dashboard.
Conclusion
I hope this short article helps you keep your desktop
clean and clutter­free. Good tinkering

BONUS TIP
If you want to remove even more widgets from your
desktop, try integrating some into the System Tray.
1. Unlock your widgets, then right click on a blank
area of the System Tray and select "System Tray
Settings".
2. Choose the "Plasma Widgets" tab (Fig. 07).
3. Place tick marks next to the widgets you would
like displayed in your system tray.
4. Click "Apply".
I find this especially useful for my weather, Gmail
Notifier and Device Manager widgets. I don't need
them all of the time. In fact, I only want to see the
Device Manager and Gmail Notifier when I plug in a
device or receive an email. Placing them in the
System Tray, a more natural setting, in my opinion,
makes them accessible while saving precious
screen real estate.

Fig. 05. The Ktorrent "Add Torrent" dialog box under
the Dashboard

Fig. 06. The default System Tray

Fig. 07. The System Tray settings dialog, with the
"Plasma Widgets" tab activated

Fig. 08. The System Tray with widgets

http://pclosmag.com/forum/index.php
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by Paul Arnote (parnote)
Of all the things that I have discovered in KDE 4 SC,
Krunner represents perhaps the most understated
change for KDE users, and cleverly cloaks its
capabilities quite well in a very simple interface.

Under KDE 3.5.x, pressing Alt+F2 brought up
Krunner (image above). The same thing happens in
KDE 4 SC, but let's just say that it has really grown
up, and now has a ton of new tricks up its sleeve.
Sure, just as in KDE 3.5.x, typing in the name of a
program you want to run will launch the specified
program. But there is so much more that it can do,
so hang on while we explore some of those added
powers and abilities. It's kind of like Clark Kent – it
appears to be meek and mild­mannered, but under
that meek veneer lies powers untapped.

As seen in the image above, there isn't much to get
excited about – at least initially. At the middle of the
popup window is where you will type in the task you

are wanting to perform. And under KDE 3.5.x, this
was the name of the program that you wanted to
run. But there are more things left to explore here.
Working from right to left, there is the "X". Clicking
on that will close out the Krunner window. Next, is
the "?" icon. Just as you might expect, clicking on it
displays help for the various functions that Krunner
is capable of performing in a popup area just below
the current window.

Clicking on the icon to the left of the entry box will
bring up the System Activity window, where you can
view all the active tasks currently running on your
system. From here, you can highlight a running task,
and click on the "Kill Process" button at the top left of
the screen. This is helpful if you have a runaway
process that's trying to bring your system to it's
knees.
By clicking on the icon at the far left of the screen,
you can specify which of the available plugins
Krunner will use. Turn them off (or, un­check them),
and Krunner will behave just like it's older and less

capable sibling in KDE 3.5.x. Turn them all on (or,
check them), and you will be able to tap into the full
potential of the new features that have been added
to Krunner. Understandably, there may be instances
(like on a network) where you may not want users to
have access to certain things, and in that case, it
makes perfect sense to limit that access by limiting
the functionality of Krunner by deselecting those
items you want to restrict access to.
So let's explore some of the new functionality that

KDE 4: Krunner Grows UpKDE 4: Krunner Grows Up
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has been added to Krunner. Starting with the basics,
let's say I want to run a calculator program. I start
typing in c ­ a ­ l into the text entry box in Krunner,
and just as soon as I type in three letters, all the
options where "cal" appears in the file names
appears in the popup window below the text entry
box. In my case, the options are "Run cal," "KCalc,"
"Local Network Browsing," "Add Locale," or
"OpenOffice.org 3.1 Calc." Simply click on the one
you want, or alternatively, hit the Tab key, and use
the cursor arrow keys to select the item you want.
Similarly, typing in the full text of "synaptic" brings up

a list of everything I can do that involves the word
"synaptic," as displayed in the screen capture below.
It gives me the options "Run synaptic," "Synaptics
TouchPad," "Synaptic Package Manager," and
"Synaptic Repair Tool."

Krunner doesn't stop there. One of the plugins that is
installed, and that you can select, is to use Krunner
as an impromptu calculator, without having to launch
a separate calculator application. Entering "=sqrt(2)"
in the text entry box immediately displays the results
in the popup window below, with 16 digits of
precision after the decimal point. Similarly, you can
put in much more complex math equations, using
parenthesis, brackets, and braces to help you set
the proper order of operations.

But wait! There's more! Krunner can also convert
units of measure on the fly. If I type in my height in

inches, Krunner immediately displays my height in
meters.
If I want another measurement other than meters, all
I have to do is tell Krunner what unit of measure I

want it to use. In the example below, I tell Krunner to
convert my height into centimeters, by entering "67.5
inches in cm" in the text entry box.
Similarly, if I type in "16 fluid ounces in m" Krunner
will display all the possible measurement

equivalents in all the liquid units of measure that
start with "m." If I do the same type of operation with
linear measurements, Krunner will display all the
possible measurement equivalents in all the linear
measurements that start with "m." (I found out that I
am just a bit more than 0.001 miles tall!)
I have only began to barely scrape the surface of all
the new functionality that the KDE developers have
built into the new Krunner in KDE 4 SC. For
example, you can directly enter bash commands
directly into the text edit box, and they will be
executed, without you having to open a separate
terminal window. Or simply enter a web address,

KDE 4: Krunner Grows Up
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and the specified page will open in your default web
browser. You owe it to yourself to further explore the
other options. But, as you can see, Krunner has
grown up and has developed some new "super
powers" that are easily accessible to you, the user.

Screenshot ShowcaseScreenshot Showcase

Posted by JohnW on June 4, 2010

KDE 4: Krunner Grows Up
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by Andrew Huff (athaki)
The KDE SC Netbook interface has been well
thought out and well implemented (with the
exception of a few caveats; which I've listed at the
end of the article.) In this article, I'll be showing you
how to enable the Netbook UI (user interface) in
PCLinuxOS 2010 and will show off some of its
features.
To get started, all you have to do is click on the
'System Settings' button at the bottom of your
taskbar. (It looks like an X made by a wrench and
screwdriver).

We'll then need to click on the desktop icon
(highlighted in the picture above). This will bring up
another menu.

In this menu we want to go to the area labeled
'Workspace'. To get to the Netbook UI, all one has to
do is switch the 'Form Factor' to netbook and click
apply.

The preceding screen is what will greet you once the
workspace has been changed. This is called the
'Newspaper' and this is where all of your widgets will
now reside. The default widgets loaded are the
openDesktop widget which is a social­
networking/file­sharing site for open­source software
users, the KnowledgeBase widget (which is part of
openDesktop), News (which is an RSS feed widget
defaulted to KDE news), and Weather.
To launch a program, click 'search and launch'. This
will bring up another screen.

From here you have two ways to navigate: clicking
an icon or typing in the name of a program. When
you start to type a name of a program, the computer
will guess the program to which you are referring.

KDE 4: The KDE Netbook InterfaceKDE 4: The KDE Netbook Interface
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You also might have noticed a menu option called
'bookmarks'. Initially it is empty, but you can add
bookmarks quite easily to programs you access
often. To do so, just hover your mouse over a
program icon and then click the yellow star in the top
left corner.

When you do launch an application, it will open full
screen with no visible toolbar. The toolbar is set to
automatically hide. Just move your mouse to the top
of the screen and it will reappear.

The toolbar is also how you are able to close
windows and move between windows. The X at the
top right corner of the toolbar will close your window
and the rectangle next to that will switch the window
between maximized and windowed mode. When you
click on the name or icon of the chosen window, all
of your currently open windows will pop up in a new
screen.

With compositing turned off, you'll get a simple menu
bar underneath the title of the current window.

KDE 4: The KDE Netbook Interface
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If you're like me and like to change around the
default wallpaper, the folks at KDE have made it
quite simple; just right­click on the 'Newspaper'
screen and/or the 'Search and launch' screen and
then click configure.

To get out of netbook mode, just repeat the steps
that you made to get into netbook mode; go into
system settings, which is at the top of the search
and launch screen, and then go into desktop, then
workspace, then change it from netbook to desktop
and click apply. You'll be back to your old desktop in
no time.

There are some caveats, however, within the
Netbook UI. Some widgets will not work or will
behave erratically when placed within the

newspaper activity and will crash the Netbook UI
(sometimes as often as every 15 minutes). When
you change the newspaper activity to a folder view
activity or a desktop activity, you can no longer add
widgets as the add widgets button makes an effort to
load and then fails. The Netbook UI seems to be the
most stable when using the default widgets provided
or not using any widgets at all. This is disappointing;
especially given that the main screen is dedicated to
showing your widgets.

Would You Like To Help?Would You Like To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get involved!
You can write articles, help edit articles, serve as a
"technical advisor" to insure articles are correct,
create artwork, or help with the magazine's layout.
Join us on our Google Group mailing list.

PCLinuxOS Enlightenment e17 ISO

KDE 4: The KDE Netbook Interface

http://groups.google.com/group/pclinuxos-magazine
http://pclinuxos.com/?page_id=184
http://www.linpc.us
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by Paul Arnote (parnote)
One of the newest features of KDE 4 (compared to
KDE 3.5.10) is the window compositing that is built
into KWin. Before, it was the relegated to the realm
of those who took the time to learn and use Compiz
Fusion. But now, window compositing is easily within
reach of most users. In KDE 4, it's referred to as
"Desktop Effects." Veteran Compiz users will most
likely view the KDE 4 Desktop Effects as "child's
play," but for the rest of us, they represent some
very nice effects that help break the monotony of
what we've become accustomed to on our desktops.
Before getting started with explaining how the new
KDE 4 Desktop Effects works, you should make sure
that your computer's graphic card is up to the task.
While official hardware requirements are
exceptionally difficult to find (if they even exist), user
reports indicate that you will need a minimum of 64
MB of video RAM to successfully run the Desktop
Effects feature of KDE 4. Reports abound from users
attempting to run Desktop Effects with 32 MB of
video RAM and less. Additionally, your video card
must support the OpenGL 3D graphics standard.
Without both, you risk locking up your computer, and
the only way to regain control is to do a hard reboot
(a sometimes dangerous proposition). I can attest to
the lock ups, as I just had to try Desktop Effects on
my old Pentium 3 with only 8 MB of video memory
on a GPU not capable of OpenGL. (Hey! I had to
try!)
To get started setting up Desktop Effects in KDE 4,
go into the KDE Control Center (KCC ... also named
"Configure Your Desktop"), and select Look & Feel »
Desktop » Desktop Effects.

The first tab in the window that opens to the right of
the selection tree in KCC is the General tab. To
enable Desktop Effects, simply place a check mark
in the box at the top. It is turned off by default. Hit
the "Apply" button at the bottom of the window to
make the selection active. Under "Compositing
State," is confirmation that compositing has been
turned on, along with a button to suspend
compositing (you may wish to temporarily suspend
compositing when you are doing CPU and memory
intensive tasks). You can also suspend and resume
compositing by pressing Alt + Shift + F12 from the
keyboard.
Under Common Settings, you can opt to turn on
"Improved window management," "Shadows" and
"Various animations." It is the latter that provides the

best eye candy. With animations activated, you can
choose from several default window switching
effects and several default effects for desktop
switching. In the screen shot above, I have selected
the "Cover Switch" effect to use for window
switching, and the "Desktop Cube Animation" as the
effect to use for desktop switching. Below is an
example of some of the default effects you can
choose from for window switching. (I don't have any
pictures of desktop switching, but you can leave that
as an exercise of discovery for yourself).

KDE 4: KWin's Desktop Effects a WinnerKDE 4: KWin's Desktop Effects a Winner
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Window switching effects: Cover Switch (top L), Box
Switching (bottom L), Present Windows (top R), and
Flip Switch (bottom R)

From the second tab, "All Desktop Effects," you can
choose from a host of other special effects. Some
you may wish to explore are exploding windows
when you close them, or magic lamp, which makes
your windows appear as if they are being sucked

into Aladdin's lamp when you minimize them. Enable
the desired effect by placing a check mark in the box
to the left of the title of the effect you want to use.
And feel free to play around with those effects and
customize your Desktop Effects.
The last tab, labeled "Advanced," is where you can
(of course) make some more advanced settings as
to how Desktop Effects are displayed on your

KDE 4: KWin's Desktop Effects a Winner
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computer. Most users will have little or no need to
mess with these default settings.
Although Desktop Effects doesn't have as many
features as Compiz, it may go a long way to opening
up window compositing to users who have never
used or considered it before. Will it fundamentally
enhance your productivity? Probably not. But then
again, since it breaks the typical monotony of the
desktop that most of us have become accustomed
to, it just may help make you more productive. If you
have the hardware to support it, you should give it a
try. You can always turn it off again if you get tired of
it.

Screenshot ShowcaseScreenshot Showcase

Posted by T6 on August 9, 2010

KDE 4: KWin's Desktop Effects a Winner

http://www.enkiconsulting.net/
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by Paul Arnote (parnote)
First came Xpdf, the PDF reader for X­Windows.
Then, Kpdf was created for KDE, based off of the
efforts of Xpdf. Then, born from Kpdf and the 2005
Google Summer of Code, came Okular, the new
universal document reader for KDE 4 SC. During the
process, Okular became a lot smarter, and learned
how to display a lot more than just PDF files.
Replacing Kpdf, Okular can now view not only PDF
files, but also most image files, OpenOffice.org
Writer (*.odt) files, postscript files, compiled HTML
Help files, EPub e­book files, faxes, and other
formats. The chart at right, from the KDE 4
Userbase, fills in the details of supported file types
that Okular can view.
Remarkably, Okular cannot currently handle
displaying simple TXT files, HTML files, or Microsoft
Office files. Okular is only capable of displaying
OpenOffice.org Writer (*.odt) files, but currently
chokes on any of the other OpenOffice.org file
formats for the rest of the OpenOffice.org office
suite. However, any shortcomings that Okular may
currently have with displaying various file formats
are likely to be filled in by developers writing
additional document format handlers for Okular.
Okular keeps all the same power and abilities as
Kpdf, and builds on it by increasing the number of
other document files it can handle or display. The
first screen shot on the next page shows Okular
doing what it does best: displaying a PDF file. It can
also annotate PDF files, and when you save the
annotated document, any other user can open the
annotated file using Okular. It can also bookmark

KDE 4: Okular Does More Than Just PDFsKDE 4: Okular Does More Than Just PDFs

http://userbase.kde.org/Okular
http://userbase.kde.org/Okular
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your PDF files, which is a handy feature when
reading PDF versions of e­books, allowing you to
save your current place in the book and to continue
reading from where you left off during a previous
reading session.
Another cool feature of Okular is it's ability to display
multiple pages. You can select for Okular to display
"facing pages" in a PDF document, or provide an
overview of all the pages (as in the screen capture
above, right, of the February 2010 issue of the
PCLinuxOS Magazine), to allow you to see how the
whole document flows and appears together.
Overall, Okular represents a giant leap forward from

Kpdf, which could only display PDF and PS files.
With the additional capability of displaying more
types of files, Okular is poised to become the one­
stop document viewing application in not only Linux,
but also every other platform supported by KDE 4
SC. Already made more powerful by it's increased
capabilities, Okular will become an unstoppable
force in document viewing, once other document
format handlers are in place, and a greater variety of
file types are supported, especially those file formats
specified earlier.

KDE 4: Okular Does More Than Just PDFs
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by Paul Arnote (parnote)
Most of you reading this already know that
PCLinuxOS is an incredibly stable operating system.
But, as with any computer operating system, things
may sometimes go awry. And when it does, you are
likely to find clues to your problem in one of the
many log files maintained on a regular basis in
PCLinuxOS. Fortunately, PCLinuxOS users have
two excellent ways to access those log files: either
through the PCLinuxOS Control Center (PCC), or
through a KDE 4 utility, called KSystemLog.

The PCC utility is located under System »
Administration Tools » View and Search System
Logs, when you launch PCC. From it, you can select
which log files you want to search through. In the
example screen shot, I've marked all five categories
of log files.
At the top of the window, you type in the term you
are searching for. I've used the term "linux," but you

can just as easily type in "eth0" or "video" or any
other term you want to search for.
Drop down vertically to the middle of the window,
and click on the "Search" button to conduct your
search. The bottom portion of the window shows
your search results, under "Content of the file."
At the very bottom of the window, you are given the
choices to "Mail alert," "Save" the data, or "Cancel"
the operation.
You can also restrict your search to only include data
specific to the selected day, in the upper right corner
of the window by simply checking the box above the
calendar that is displayed. You can also further
refine your search by specifying a term you wish to
exclude from your search results, by filling in that
term in the "but not matching" box.
Of course, the PCC method of viewing and
searching your log files is available to every user
running any version of PCLinuxOS, regardless of
the desktop environment you are using. Just
remember you will have to supply a search term.
However, if you are running KDE 4, you have
another choice that allows you to view your log files,
without specifying a search term. You can use
KSystemLog, which is installed from Synaptic as
part of the KDEAdmin4 package. KSystemLog is
designed to make it easy for beginning KDE users to
find the various system logs on their system, but
also designed to make the log files accessible and
useful for more experienced users.

Just as with PCC, you will need to supply your root
password when launching KSystemLog. When it
opens, you are presented with the System Log
preloaded, as in the second screen shot.
If you want to view a different log file, simply click on
one of the log files listed across the top of the
KSystemLog window, or select one from the "Logs"
menu (there are quite a few more log files listed
under the "Logs" menu than just those listed across
the top of the window). By doing so, the log you
select will replace the System Log in the main
window.
KSystemLog also sports a multiple tab interface, so
you can view multiple log files at one time. By
pressing Ctrl + T, or by selecting Window » New Tab
from the menus, you can open up a new tab, and
select which log file you would like to view in that
tab.

KDE 4: KSystemLog Reveals Your Log FilesKDE 4: KSystemLog Reveals Your Log Files
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If you select a log file that does not exist, or cannot
be found in the default location, you will receive the
following error message box:

Fortunately, there are quite a few configuration
options for KSystemLog.

Under the General section, you can specify which
log file you want to be loaded by default when
KSystemLog starts. The default is System Log, but
you can choose to have no log file automatically
loaded, or you can choose from 16 other log files.
They include:
* ACPI Log
* Apache Access Log
* Apache Log
* Authentication Log
* Cron Log
* Cups Web Log1000
* Cups Log
* Cups Page Log
* Cups PDF Log
* Daemons' Log
* Kernel Log
* Postfix Log
* Samba Access Log
* Samba Log
* X.org Log
* X Session Log
Right below the selection of the log file to load when
KSystemLog starts, you can specify how many lines
of the log file to load. Some of the log files, due to
how complete and complex they are, can become
quite long. The default number of lines to load is
1,000. In the example above, I've increased the
maximum number of lines to 2000. You also have an
option to remove duplicate lines, although doing so
may cause slower loading of the log files.
When you select the individual log files listed on the
left side of the Configuration, you are given the
chance to specify a different location where each log

file resides, just in case log files are stored in
different locations from Linux distro to distro.

Somewhat surprisingly, the Boot Log was left out of
the choices you can choose to view. Never fear, as
you have a couple of options. First, you can simply
point one of the log file categories to load the Boot
Log, instead of the one it's suppose to display. The
only shortcoming to this is that the Boot Log will
always be displayed with the name of the category
you chose to change. For example, if you specify the
Boot Log in place of the Apache Access Log, the
label will still read Apache Access Log, while
displaying the Boot Log. The other way to display
the Boot Log is to add it to the end of the System
Log. Select "Add File ..." from the configuration
dialog box, and select the Boot Log from the list of
logs that occupy /var/log.

KDE 4: KSystemLog Reveals Your Log Files
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With KSystemLog, you can search the log file being
currently displayed (Edit » Find...). You can also
save the log file (File » Save), and you can even add
an entry to the currently displayed.
All in all, Linux is about choice. Every PCLinuxOS
user can view and search the log files on their
system through PCC. And KDE 4 users have
another choice to use the KDE 4 tool, KSystemLog.

Visit Us On IRCVisit Us On IRC
• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)
• Go to freenode.net
• Type "/join #pclinuxos­mag" (without the quotes)

1. All the contents of the NEW PCLinuxOS Magazine are only
for general information and/or use. Such contents do not
constitute advice and should not be relied upon in making (or
refraining from making) any decision. Any specific advice or
replies to queries in any part of the magazine is/are the
person opinion of such experts/consultants/persons and are
not subscribed to by the NEW PCLinuxOS Magazine.

2. The information in the NEW PCLinuxOS Magazine is
provided on an "AS IS" basis, and all warranties, expressed
or implied of any kind, regarding any matter pertaining to any
information, advice or replies are disclaimed and excluded.

3. The NEW PCLinuxOS Magazine and its associates shall not
be liable, at any time, for damages (including, but not limited
to, without limitation, damages of any kind) arising in contract,
rot or otherwise, from the use of or inability to use the
magazine, or any of its contents, or from any action taken (or
refrained from being taken) as a result of using the magazine
or any such contents or for any failure of performance, error,
omission, interruption, deletion, defect, delay in operation or
transmission, computer virus, communications line failure,
theft or destruction or unauthorized access to, alteration of, or
use of information contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom the NEW
PCLinuxOS Magazine has no control or connection, business
or otherwise. These sites are external to the NEW
PCLinuxOS Magazine and by visiting these, you are doing so
of your own accord and assume all responsibility and liability
for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The NEW PCLinuxOS Magazine accepts no responsibility for
the content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

KDE 4: KSystemLog Reveals Your Log Files
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by Alain Baudrez (Wamukota)

If you are like me, you like listening to music while
working at the computer. Most desktops have a nice
set of external good quality speakers attached
because you like good quality. If you have a laptop
that audio quality is sometimes a far­fetched dream.
In come the external USB speakers set. You find a
nice set, buy one, come home, plug it in, the control
led lights up and … nothing. Sound still comes
through the laptop's speakers, though. Does that
mean that the USB speaker set is not recognized?
Maybe, but mostly it is just a case of telling
PCLinuxOS to get its priorities right.

Modify the system settings:
* Open the 'Configure Your Desktop' application
* Select the option 'Computer Administration'
* Activate the 'Multimedia' option
* Select the Device Preference 'Audio Output' ­
'Music'

You'll be presented with a similar interface (bottom).
As you see, on my box, both the internal (ATI) and
external (USB) audio devices are recognized, with
the internal one being the one with the highest
priority.

Change the priority
It is just a matter of sliding the internal card below
the USB speakers (click on it with the mouse and
drag it to the second position), and now your
external speakers will be used to output audio from
your audio applications.

Do the same for the other Output devices. (Video,
Communication, …)
Configure KMix
Right­click on the KMix icon in the systray, and
configure the USB device.
Don't forget to set the 'Master Channel' to your USB
device if you want to control the audio level using
KMix.
Disconnected USB speakers
If you disconnect the external speakers, this is
reflected in the System Settings, as the USB entry is
grayed out.

Configuring PCLinuxOS 2010 KDE 4For External USB Speakers
Configuring PCLinuxOS 2010 KDE 4For External USB Speakers
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In that case, the second device – the internal audio
card – will be automatically selected. Upon logging
in, a temporary warning message appears on top of
your screen or through KNotify and you are back in
the 'old' PCspeaker output.
The next time you plug in the USB speakers, they
will be used.

Nice to know
Although you now have the correct settings, some
applications might still output their audio through the
PC speakers. In that case, it is just a matter of
modifying the program's audio preferences and
selecting the USB speakers as main audio output
device.

Configuring PCLinuxOS KDE 4 For USB External Speakers

http://www.pclinuxos.com



